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Introduction 
The ProPower3 (PP3) software can be used to communicate with a Profile Portable Energy Monitor to download 
survey data and change the unit's settings and recording modes/parameters. 
 
The same software provides comprehensive data analysis tools allowing the user to gain a good understanding of 
the energy use recorded during a Profile survey. From PP3 version 3.7 onwards, analysis of Recon T energy survey 
data is also possible with data first being exported as a CSV file from the MedcalScope software. 
For details of the Profile's capabilities and instructions in its use please refer to the hardware documentation. 

System Requirements 
The ProPower3 software relies on the Java Runtime Environment. This is however included within the software 
installation routine so no other installations are required. 
For PC installation Window 7 or later is required. 
PP3 is a 64 bit application and hence requires a 64 bit environment in which to run. 
 
Before connecting your Profile Portable Energy Monitor to a computer and attempting communications from the 
ProPower 3 software, it is necessary to install the USB drivers. 
Drivers appropriate for your operating system can be downloaded from https://www.ftdichip.com/Drivers/VCP.htm. 

Installation 
To install the ProPower3 software on your machine; 
PC; Run the PP3-Setup-V*.exe installation package and follow any on screen instructions. 
 
Before installing a later version of the ProPower 3 software, it is advisable to first uninstall any existing version. 
The ProPower 3 software can be uninstalled in the usual way via the Windows Control Panel. 

Software Startup 
Once installed, ProPower3 can be started via the desktop or start menu shortcuts in Windows. 
These can be identified by the PP3 icon: 

  
 
 

 
When first started the software will display the following screen; 

 
 
From this screen the user can choose to load a survey data file for analysis, or to instigate communications with a 
Profile. 
 

 

https://www.ftdichip.com/Drivers/VCP.htm
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Installing a License Key 
When first installed, the ProPower 3 software will run in demonstration mode.  
In demo mode data analysis is limited to internal data only. Downloaded survey data files can not be loaded into the 
software. 
To enable full software operation a valid license key must be purchased and installed. 
 
To install a license key, open the ProPower3 software and select 'About' from the 'Help' menu; 
 

 
 
Enter your license key in the text box and click the 'Submit' button. 
The license key will be in the form XXXX-XXXX-XXXX and must be entered in capital letters and including the two 
dashes (-). 
 
To purchase a license for the ProPower 3 software please contact NewFound Energy Ltd. 

Main Menu Bar 
The main (Summary Report) screen has a menu bar with five menus. 
 

 
 
 
File Menu; 

 
 
Load data File   - displays the 'Select Data File....' window from where a Profile data file can be loaded. 
Log On to Profile   - instigates communications with a connected Profile. 
Settings      - displays the system setting window. 
Close       - closes PP3. 
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Summary Menu; 

 
 
Save Summary As Image - saves the summary report as a PNG file with a user specified location & file name. 
Copy Summary to Clipboard - saves the summary report as an image to the clipboard for pasting into other  
        documents or programs. 
View Summary As PDF - opens the summary report as a PDF document (Acrobat Reader must be installed). 
 
Data Menu; 

 
 
View Data  - view the raw survey period by period data as a CSV document. 
Export data - export the raw survey period by period data as a CSV document with a user specified location & file 
    name. 
View Charts - open a PP3 Chart window. 
 
Reports Menu; 

 
 
Build XLS Report  - build an XLS report based on the template .xls file. 
Build PDF Report - build a PDF report based on the selected settings. 
 
Help menu; 

 
 
Help - provides access to this document. 
About - displays software version and contact information. 
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ProPower 3 Software Settings 
The settings screen provides options for various areas of the PP3 software. 

 
 
Summary Report 
Set the Night Start & Night End times to be used when calculating the Night Time Consumption & Day Time 
Consumption figures on the Summary Report. If no selection is made/saved, night time will be defined as 00:00 to 
07:00. 
 
Data Export 
'Include column headers in data export'  
Tick this option to include headers for each column in the CSV file created when the raw survey data can is viewed or 
exported as a CSV file via the 'Data' menu.  
 
The headings are as follows. 
Date, Period End Time, kW1, kW2, kW3, kW Total, kVAr1, kVAr2, kVAr3, kVAr Total, kVA1, kVA2, kVA3, kVA Total, 
PF1, PF2, PF3, PF Total, Volts1, Volts2, Volts3, Amps1, Amps2, Amps3, Amps Total, Pulse Input 1, Pulse Input 2. 
 
XLS Report; 
Set the path to the template Excel (.xls) file that should be used for the generation of the XLS report. The text box 
should be left entirely blank to use the default template. 
 
PDF Report; 
Tick the options to include when generating a PDF report. 
 
Communication; 
'Automatically scan available ports for Profile'  
when ticked the software will try to find a connected Profile immediately after the 'Log On' option is clicked via the 
'File' menu, or on the 'Select Data File....' window. 
If this option is not ticked the user will be required to select a comms port before communications with a Profile will 
be attempted. 
 
Set communication for Profile with Firmware v5.16 or earlier’'  
This option should be ticked if your Profile has firmware version 5.16 or earlier. Unticked otherwise.  
With an incorrect setting here, downloading of survey data may not work correctly. 
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Communicating with a Profile 

 
 
 
 
 
 

 
 

Logging On to a Profile 
Before it is possible to download survey data, or change Profile settings, a connection to the Profile must be 
established. You must therefore Log On to the Profile. 
Before attempting to Log On to a Profile please ensure that it is powered and connected to a USB port on your 
computer. Please also ensure that (as per the note above) USB drivers suitable for your computer have been installed. 
 
Communications with a connected Profile can be instigated either via the 'Log On to Profile' option on the File menu; 

 
 
 or via the 'Log On' button on the 'Select Data File....' box; 

 
 
When either of these is clicked, the PP3 communications ('Profile Data Download & Setup') screen will open as a new 
window. 
 
If the 'Automatically scan available ports for Profile' option in PP3 Settings is ticked, the PP3 software will 
automatically begin scanning available comms ports for a Profile; 

 
 
 

N.B. Profiles with USB Connection 
The Profile Portable Energy Recorder use a USB connection (‘USB Mini B’ type) to connect to the PC. It is vital that 
the USB drivers are installed before the Profile is connected to your PC’s USB port. 
 
A version of the USB connection drivers will be located on the PP3 installation disk. For the latest version for your 
operating system please visit http://www.ftdichip.com/Drivers/VCP.htm. 
The USB drivers installation file will be of the form ‘CDM21216_Setup.exe’ (Windows. Version number may vary). 
Please run this file to install the USB drivers before connecting the Profile to a USB port. 
 

http://www.ftdichip.com/Drivers/VCP.htm
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If the 'Automatically scan available ports for Profile' option in PP3 Settings is not selected, then the user must 
manually select the comms port to which the Profile is connected before clicking the 'Log on' button; 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

N.B.  
Even though you are connecting the Profile to a USB port, Windows assigns a comms port number to it. 
The comms port number in use can be seen in Windows Device Manager. The Profile will appear as 'USB Serial 
Port' in the 'Ports' section, with the comms port number shown after the description. When a Profile is connected, a 
'USB Serial Converter' entry will also be present in the 'Universal Serial Bus controllers' section. 

 
 
 
 
 
 
 
 
 
 
 

Tip 
In general it is easier to allow the PP3 software to scan for the connected profile automatically (tick the 
'Automatically scan available ports for Profile' option in PP3 Settings). 
Over time however, if you frequently connect & disconnect different hardware to your computer's USB ports, you 
may find that some comms ports become permanently assigned by Windows and unavailable*. 
When this occurs it may take some time for the PP3 software to scan all available ports and find a connected Profile. 
 
As an alternative, the 'Automatically scan available ports for Profile' option in PP3 Settings can be unticked, the 
comms port number in use by the Profile can be checked in Device Manager and that port selected before manually 
logging on. 
 
[*Doing so is beyond the scope of this document and is not necessarily advisable, but instructions can be found on 
the internet detailing how to remove (uninstall) these 'hidden comms ports'. If you decide to do this please be careful, 
and do not to uninstall anything that relates to connected equipment] 
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Once successfully connected to a Profile, the software will display live readings on 6 dials, and above the dials a 
selection of the current Profile setting; 
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Data Download & Setup Menu 
 

 
 
The Data Download & Setup windows has its own menu bar with 'File', 'Communications' & 'Profile Settings' 
menus. 
 
 
File menu; 

 
 
Close - log off any connected Profile and close the Profile Data Download & Setup window. 
 
 
Communications menu; 

 
 
Log On    - attempt connection to a Profile connected to the selected comms port. 
Log Off    - close the connection with the connected Profile. 
Download Survey Data - opens the 'Set Survey Download Parameters' window to allow downloading of 
    survey  data. 
 
Profile Settings menu; 

 
 
View Logging Setup - view and adjust the Logging & Clock settings 
View Current Setup - view and adjust the Current settings 
View Voltage Setup - view and adjust the Voltage settings 
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Downloading Survey Data (Firmware >5.16) 
Once logged on to a Profile, the Download Survey Data option becomes available on the Communications menu. 
The 'Download Survey Data' button is also enabled. Either of these can be used to open the 'Set Survey Download 
Parameters' window; 
 
 
 
 
 

 

 

 

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Once all selections have been made, and the 'Download Data' button clicked, data download will begin and an 
indication of the download in progress will be shown; 
 

 
 

On completion of the download, the download parameters window will close, and the software will return to the main 
Data Download & Setup window. 
 
The data file created can now be loaded into the PP3 software for analysis. 

1. Set the start date of 
the data you wish to 
download. 
 

2. Set the end date for 
the data you wish to 
download. 
 

4. Click 'Download 
Data' to start the 
data download. 
 

3. Set the file (location & 
filename) to which the 
data should be saved. 
 

N.B. 
a) Data will be downloaded for whole days inclusive of the start & end dates selected. When analysing the survey 
data, options exist to set alternate start and end dates & times. 
b) The data is downloaded as raw text. If the file selected for the data already exists, it will be overwritten. 
c) Long surveys, particularly those using short integration periods can take a little time to download. Please do not 
disconnect the Profile during the downloading of data.   
d) No attempt should be made to download data from prior to the memory capacity of the Profile. Doing so may 
corrupt the data file or provide misleading figures. 
 
Profile memory Capacities; 
30 minute periods - 12 weeks 
15 minute periods - 6 weeks 
10 minute periods - 4 weeks 
5 minute periods - 2 weeks 
1 minute periods - ~2days 
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Downloading Survey Data (Firmware 5.16 or earlier) 
Once logged on to a Profile, the Download Survey Data option becomes available on the Communications menu. 
The 'Download Survey Data' button is also enabled. Either of these can be used to open the 'Set Survey Download 
Parameters' window; 
 
When this area is first opened, the software will begin searching for available surveys to download. This may take up 
to a minute. During this time ‘Searching for survey data, please wait…’ will flash at the bottom of the window. 

 
 

Once survey data has been found, the survey dates will be listed and may be selected for download. 
 

 

 

 

 
 
 
 
 
 
 
 
 
 
 
 
Once all selections have been made, and the 'Download Data' button clicked, data download will begin and an 
indication of the download in progress will be shown; 

1. Select (click on) the 
survey that you wish to 
download. 
 

2. Set the file (location & 
filename) to which the 
data should be saved. 
 

N.B. 
a) Data will be downloaded for whole days inclusive of the start & end dates selected. When analysing the survey 
data, options exist to set alternate start and end dates & times. 
b) The data is downloaded as raw text. If the file selected for the data already exists, it will be overwritten. 
c) Long surveys, particularly those using short integration periods can take a little time to download. Please do not 
disconnect the Profile during the downloading of data.   
d) No attempt should be made to download data from prior to the memory capacity of the Profile. Doing so may 
corrupt the data file or provide misleading figures. 
 
Profile memory Capacities; 
30 minute periods - 12 weeks 
15 minute periods - 6 weeks 
10 minute periods - 4 weeks 
5 minute periods - 2 weeks 
1 minute periods - ~2days 
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On completion of the download, the download parameters window will close, and the software will return to the main 
Data Download & Setup window. 
 
The data file created can now be loaded into the PP3 software for analysis. 
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Profile Hardware Settings 
The default settings configured when your Profile was supplied are suitable in most circumstances. 
It is however possible to change these if required via the Data Download & Setup area of the PP3 software. 
 
 
 
 
 
 
 
 
In order to change the settings in your Profile it must be connected to your computer and the PP3 software must be 
logged on to it. 
 
 
Three areas exist that allow changes to be made to the Profile settings. All three are accessed via the Profile 
Settings menu. 
 

Logging & Clock Setup; 

 
 
 
Current Date & Time   - displays the date & time as read from the Profile internal clock 
Set Date & Time   - set the Profile's date & time.  
Logging Period   - click the Change Period button to toggle between available logging periods 
Automatic or Manual Logging Start - click the Toggle Autolog button to switch between auto & manual logging 
Logging Start Time   - when in manual logging mode, set the date & time at which logging should 
     start (this option is available only when Logging Start is set to 'Manual'. 
Clear memory    - clear the logger memory of previously recorded survey data. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

N.B. 
Please be careful when changing the settings of your Profile. Some settings can lead to incorrect or misleading data 
being recorded during surveys. 
 
Changing some settings will also lead to the Profile's memory being cleared. 
 

N.B. 
For most surveys 30 or 15 minute logging periods are suggested and Auto Logging should be set. 
 
Logging Period:  
Although setting the logging period to a smaller duration will store data with more definition (more data records will 
be stored), recorded figures are no less accurate at the longer logging period settings. 
E.g. Over a 30 minute survey the kWh usage recorded on 15 min periods might be 10 kWh & 20 kWh. 
On 5 min intervals, they might be 3 kWh, 4 kWh, 3 kWh, 4 kWh, 6 kWh & 10 kWh - the totals over the 30 
minutes are the same, the 5 minute period data just gives more data points. 
The default of 30 or 15 minute recording intervals is sufficient for most surveys. Lower recording intervals are 
only advised where the user needs to know what fluctuations occurred within those default periods. 
Logging periods available for the user to set are 60, 30, 15, 10, 5 or 1 minute. 
Intervals of less than 1 minute are available for selection but the PP3 software can not be used to analyse data 
recorded using them. The recording capacity is also greatly reduced so using them is not recommended.  
 
.... 
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Current Setup; 

 
 
Full Current Range  - the current range presently in use by the Profile. Click the Toggle Range button to 
    switch between available current ranges (available only in Manual Ranging mode). 
Auto/Manual Ranging  - click the Auto/Manual button to toggle between automatic and manual current  
    ranging. 
Full/Part Current Mode  - click the Part/Full button to toggle between current modes. 
Existing CT Ratio  - displays the CT ratio in use (only when Part Current Mode is in use) 
Set CT Primary   - enter the required CT primary in the box and click the Set CT Primary button to 
    change the CT ratio (only available when Part Current Mode is in use). 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

N.B. 
For most surveys the Profile should be left in Automatic Current Ranging & Full Current modes. 
 
Full Current Range & Auto/Manual Ranging 
The Profile can be set to one of four current ranges, 0-6A, 0-120A, 0-500A, & 0-2000A. 
In Auto Ranging mode, the Profile will automatically switch to the most suitable range as the current being 
measured fluctuates. 
This can be manually overridden by setting the Profile into Manual Ranging, and manually fixing the Current Range. 
Please bear in mind that when Manual Ranging is selected, if the current moves out of the selected range recorded 
data will not be accurate. 
 
.... 

.... 
Automatic or Manual Logging Start: 
In automatic logging mode the Profile will log whenever it is powered (please note that the installation 'auto 
phasing' routine should be completed whenever the Profile is installed for a survey - see the Profile 
Installation Guide). 
 
In manual logging mode the Profile will start logging only at the date & time set. This can be useful when using the 
shorter logging periods.  
However, when analysing the survey data in PP3 it is easy to select any start/end date & time for reports & charts, 
so it is usually not necessary to set the Profile to manual logging mode. 
 
Clear Memory 
It is not usually necessary to manually clear the Profile's memory after each survey. When the memory capacity is 
reached the memory will wrap around overwriting the earliest data stored. 
 
Tip 
Profile memory Capacities; 
30 minute periods - 12 weeks 
15 minute periods - 6 weeks 
10 minute periods - 4 weeks 
5 minute periods - 2 weeks 
1 minute periods - ~2days 
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Voltage Setup; 

 
 
LV/HV Mode    - select low or high voltage operation (Profile V only. Please see hardware 
     guides for more information on monitoring of HV circuits) 
Auto/Manual Voltage Ranging  - click the Auto/Manual button to toggle between automatic and manual  
     voltage ranging 
Phase Mode    - click the 1 or 3 Phase button to toggle between single and three phase  
     operation (available for selection only in manual ranging mode although  
     setting is retained in automatic mode) 

 

 

 

 

 

 

 
 
 
 
 
 
 
 
 
 

N.B. 
For most surveys the Profile should be left in Automatic Voltage Ranging mode. 
 
Auto/Manual Voltage Ranging & 1 or 3 Phase modes 
In normal use the Profile should be left in Automatic Voltage Ranging mode. Manual voltage ranging is used for 
monitoring of HV circuits (when VTs are in use). 
However, in order to set the Profile into single phase mode, it must first be set to manual voltage ranging. 
Once single phase mode has been enabled, the Profile should be set back to automatic voltage ranging. 
 
Tip 
For most single phase surveys it is not necessary to set the Profile into single phase mode.  
Instead, simply use the phase 1 (red/brown) coil, ensure that the voltage in use is from the same single phase 
supply, and follow the usual 'auto phasing' routine (see the Profile Installation Guide: Single Phase Energy 
Monitoring Surveys). 
 
 

.... 
Full/Part Current Mode  & CT Ratio/Primary 
In some circumstances the Profile coils can be installed around 5A CT output tails rather than the actual supply 
cables. 
In this scenario the Profile should be set to Manual Ranging and Part Current mode, and the CT Primary set to 
match the primary current rating of the CTs. 
The Profile will then set itself into the 0-6A measurement range and will automatically multiply up the measured 
current using the set CT ratio.  
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Analysing Survey Data 

Loading a Data File 
Once the raw survey data file has been downloaded from a Profile, it can be loaded into the PP3 software for analysis. 
The 'Select Data File....' box is available when PP3 is first started but can also be accessed at any time by selecting 
'Load Data File' from the 'File' menu.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Once the survey data file is loaded, the Summary Report will automatically load. 
 
*Recon T data exported from MedcalScope (4.3.51 or later) must have been exported with the following 
settings (see Addendum 1 – Importing data from a Recon T survey for more information): 
On Energy tab: Untick 'Aggregate in intervals': 

 
 
In Data export configuration: Untick ‘Include standard header’. 
Decimal separator: Set to ‘Point’. 
Selected values: 
U: RMS Voltage 
I: RMS current 
PF: Power Factor 
Ea: Active Energy 
Er: reactive energy 
avg 
L1 
L2 
L3 
 
Export with 'Save as type:' set to 'Text File, comma separated values'. 
 

6. Click 'Load 
Data' to load the 
selected data file. 
 

2. Set a survey 
title. This is used 
as a heading for 
report & chart 
screens 
 

5. Set the data multiplier. 
This can be used to 
multiply the recorded data 
if a survey was performed 
with the Profile coils 
around only one of two 
sets of balanced supply 
cables for example. 
In most cases it should be 
left as 1. 
 

1. Set the path to the 
saved Profile data file 
either by typing in the 
full path to the file 
(including the 
filename) or by clicking 
'Browse' to select the 
file. 
 
3. Tick if survey was 
performed on a single 
phase circuit. 
 

4. Tick if data file is 
Recon T data exported  
from MedcalScope*. 
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Summary Report 
The Summary Report details various parameters from the loaded data file including consumption figures, period 
demands, phase balance & more. 
 
 

 
 
When first opened the report will include data from the whole of the loaded data file. 
Alternate start and end dates & times for the report can be selected via the toolbar. After clicking 'Apply' the new start 
& end times will be used to recalculate the Summary Report figures.  
 
 
 
 
 
 
 
 
 
 
 
 
The 'Summary' menu on the main menu bar, and the context (right-click) menu provide options for saving or 
exporting the Summary Report. 
    
 
 
 
 
 
 
 
 
 
 

N.B.  
a) The 'Min' figures in the Summary Report exclude zeros. 
b) Night time is defined here as 00:00 to 07:00 by default. Custom night hours can be set in Settings. 
c) The 'Projected Month' & 'Projected Year' figures are intended as a guide only. They simply divide the total figures 
by the number of days included in the summary report before multiplying by 30 or 365 respectively. 
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XLS Report 
The XLS report can be created at any time after a data file had been loaded. By default it uses a template .xls file that 
is included within the PP3 program. 
To create an XLS Report select the 'Build XLS Report' option from the Reports menu 
 
To make production of the XLS report possible, the computer in use must have software installed capable of opening 
Microsoft Excel® (.xls) file. The XLS report will open directly in this program. 
 
The raw, period by period demand and consumption data is loaded into the first two spreadsheet tabs/worksheets. 
On subsequent worksheets various functions can be used, linking to the first two worksheets to produce the report 
data. 
 
Using the XLS Report functionality, it is possible to create a custom report to suit your exact needs.  
To do this, a custom template .xls file can be created using Microsoft Excel® or another spreadsheet program.  
The first two worksheets of any xls template should be left as they are in the default template to allow the PP3 
software to populate them with the period by period demand & consumption data from the loaded survey file. 
 
Once created the custom xls file should be saved to a suitable location and the path to it set in the XLS Report area of 
the PP3 Settings. 
 

 

PDF Report 
The PDF report can be created at any time after a survey data file has been loaded. To create an PDF Report select 
the 'Build PDF Report' option from the Reports menu 
  
The pages to be included in the report can be set within the PP3 Settings area.  
 

 
 
 
 
 
 

N.B.  
a) The XLS report produced will include data for the latest date & time range applied to either the Summary Report 
or a PP3 Chart. 
b) To make production of the XLS report possible, the computer in use must have a program capable of opening 
Microsoft Excel® (.xls) files installed. 
 
Tip 
When creating your own template .xls file, use the supplied default template as a basis for it.  
The first two tabs/worksheets (named Survey_Demand_Data & Survey_Consumption_Data) are populated by the 
PP3 software, all other worksheets link to the data in the first two tabs/worksheets using various functions. 
There is also some formatting in these first two worksheets that ensures the XLS Report can be produced 
successfully, and that the functions used operate correctly.  
It is therefore essential that the first two worksheets (named Survey_Demand_Data & 
Survey_Consumption_Data) above are present and unchanged in any custom xls template file used.  
 
To ensure compatibility, all templates for the XLS Report should be saved as an .xls file (rather than the later .xlsx 
format). 
 

N.B.  
a) The PDF report produced will include data for the latest date & time range applied to either the Summary Report 
or a PP3 Chart. 
b) To make production of the PDF report possible, the computer in use must have a program capable of opening 
Adobe Acrobat® (.pdf) files. 
 
 
Tip 
The PDF report can take some time to build, so it is advisable to select only the options required in the PP3 Settings. 
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PP3 Charts 
The PP3 Charts allow graphs to be displayed for any of the electrical units available in or calculated from the Profile 
survey data file. Graphs can include individual phases or phase totals, over any date/time period within the range of 
the loaded survey file.  
 
Any number of chart pages can be opened (within the capabilities of the computer in use!) via the 'View Chart' button 
on the main PP3 (Summary Report) screen, or via the 'View Charts' option on the 'Data' menu.  
Each chart opens in an individual window. 
 

 

 
Charts can be displayed as stacked bars, lines, pie charts. When the stacked bar or line chart option is selected for the 
main chart, an overlay line chart can be added with its scale on the right-hand side of the chart window. 
 

N.B.  
a) Subject to the caveat in b), when first opened the chart produced will include data for the latest date & time range 
applied to either the Summary Report or a PP3 Chart. 
 
b) On first opening a chart window you may be presented with the following warning; 
 

 
 
This warning is displayed when the number of data points in the date/time range selected exceeds the number that 
the monitor in use can display (no. of data points > screen width pixels). 
In order to prevent the chart taking too long to load, the end date/time has been adjusted so that the number of data 
points does not exceed the screen width. 
If desired, the settings applied can be overridden manually but please bear in mind that the chart displayed will be as 
accurate a representation of the data as your monitor can display, but it will not be exact. 
 
c) If the survey was set as a Single Phase Survey when the data file was loaded, some options will not appear. For 
example the Phase 2 & 3 selection boxes, and Pie Chart option will not be available. 
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At the bottom of each chart window is displayed the chart key and associated totals or average values relating to the 
unit being displayed. 
 

 
 
When the mouse curser is placed over the chart area a period value 

 
or point value will be displayed at the very bottom of the chart window; 

 

 

Chart Menus 
Each chart window has its own menu bar with options as follows; 
 
File Menu; 

 
 
Save Chart As..    - save the chart displayed as an image (.png) file with a specified location & filename. 
Copy Chart to Clipboard - copy the displayed chart to the clipboard for pasting into other programs/documents. 
Close       - close this chart window. 
 
View menu; 

 
 
Show Options   - toggle the Chart Options panel between shown & hidden 
View Chart as PDF - open the displayed chart as a PDF document (Adobe Acrobat® or other suitable software 
       must be installed) 
 
 
A context (right-click) menu is also available; 

 
 
Copy Chart to Clipboard - copy the displayed chart to the clipboard for pasting into other programs/documents. 
Save Chart As..    - save the chart displayed as an image (.png) file with a specified location & filename. 
View Chart as PDF  - open the displayed chart as a PDF document (Adobe Acrobat® or other suitable 
        software must be installed) 
Show/Hide Options  - toggle the Chart Options panel between shown & hidden 
Undo Zoom     - return the start and end dates & times to their original settings. 

Tip 
When selecting View Chart as PDF, Save Chart As.., or Copy Chart to Clipboard, the size of the saved image is 
determined by the on-screen size of the chart. To make the image fit a particular page/paper size you should 
therefore adjust the on-screen chart to suit before selecting one of the menu options. 
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PP3 Chart Options 
The Chart Options panel allows each PP3 Chart to be set to unique display options. 
In order to allow a 'full screen' view of the chart, the options panel can be hidden via the View or context (right-click) 
menu option. 
 
Start & End Dates & times; 

 
 
Set the start & end dates & times for the chart. Start times are period start, end times are period end. 
These apply to both the Main & Overlay charts. 
 
Main Chart; 

 
 
Display phases: Phase 1, Phase 2, Phase 3, Total tick boxes allow the individual phases or circuit total to be 
displayed. 
 
Units: Select the unit to be displayed. All the electrical consumption (kWh, kVAh, kVArh) and demand (kW, kVA, 
kVAr) units can be selected along with the period average amps, period average volts, period average power factor, 
and pulse inputs 1 & 2. 
 
Chart Type: Select to display stacked bar chart, line chart, or pie chart. 
 
Fix Scale: The chart will auto-scale to suit the displayed values by default but chart scaling can be overridden to a 
specific range using this option. 
 
Overlay Line Chart; 

 
Display phases: Phase 1, Phase 2, Phase 3, Total tick boxes allow the individual phases or circuit total to be 
displayed. 
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Units: Select the unit to be displayed. All the electrical consumption (kWh, kVAh, kVArh) and demand (kW, kVA, 
kVAr) units can be selected along with the period average amps, period average volts, period average power factor, 
and pulse inputs 1 & 2. Selecting 'None' removes the overlay chart from display. 
 
An extra option exists within the Overlay Chart units menu; 

 
When set, this option will draw a horizontal line across the chart at the specified value. 
 
Match Scale to Main Chart: As with the Main Chart, the Overlay Chart will auto-scale to suit the displayed data by 
default. The main (left-hand) and overlay (right-hand) scales can be forced to match using this option to allow more 
accurate comparisons between units to be made. 
 
Fix Scale: By default the chart will auto-scale to suit the displayed values. Using the Fix Scale option overrides this to 
set scaling to a specific range.  
 
When all options have been set as required, click the 'Apply' button to redraw the chart. 
 
 
Chart Zooming; 
it is also possible to zoom in to a particular date/time range on a chart by dragging a 'zoom-box' with the mouse. 
To do this, click and hold the left mouse button within the chart area in line with the point on the date/time axis that you 
want the chart to start. 
The drag the mouse to the right, releasing the mouse button at a point in line with desired end date/time. 
 
Whilst dragging the mouse in this manor, a green 'zoom' box will appear. 

 
 
 

 

Tip 
At any time the chart can be returned to the original start & end dates & times via the 'Undo Zoom' context (right-
click) menu option. 
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Addendum 1 – Importing data from a Recon T survey 
 
From ProPower 3 version 3.7.1.1 onwards it is possible to use the ProPower 3 software to analyse data from a survey 
performed using the Cesinel Recon T Energy Monitor. 
There are however specific requirements that must be followed in order to make this possible. 
 
 

Step 1 - Export Data from MedcalScope 
After completing a survey with the Recon T, data must be downloaded from it using the associated MedcalScope 
software. Please refer to Cesinel documentation for complete information on this. 
 
 
a) Once the downloaded survey data is open within the MedcalScope software, the date range on view should be set 
to suit the data that you wish to analyse within PP3. 
(N.B. when downloading data from a Recon T, the MedcalScope software retrieves all data within the hardware 
memory. If the Recon T memory is not cleared between surveys this will therefore include data across multiple 
possibly unrelated surveys): 

 
 
 
b) Still within MedcalScope, select the Energy tab and ensure that the Active Energy & Reactive Energy tick boxes 
are ticked, that the Aggregate in intervals tick box is unticked, and that the interval is set as appropriate for the 
survey data (must be >1min for analysis in PP3). 

 
 
 
 
c) Within MedcalScope select Export data from the File menu. 
Within the Data export configuration window use the following settings: 
Include standard header: Unticked 
Decimal separator: ‘Point’. 
Selected values/tick boxes: 
U: RMS Voltage 
I: RMS current 
PF: Power Factor 
Ea: Active Energy 
Er: reactive energy 
avg  
L1 
L2 
L3 
All other tick box options should be unticked. (see screen shot on next page) 
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d) Once the appropriate options have been selected, click the OK button on the Data export configuration window. 
Then browse to the place in which you wish to save the exported data file and give the file a suitable File name. 
In the Save as type: option select Text file, comma separated values: 

 
 
 
e) Save the file and close MedcalScope. 
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Step 2 – Load Exported Data into PP3 
The file exported from MedcalScope can then be loaded into PP3: 
 
a) After opening PP3, select the exported Recon T data and tick the Recon T Data tick box before clicking Load 
Data: 
(Single Phase Survey should be ticked if appropriate) 

 
 
The full range of PP3 analysis tools are then available (depending upon survey specifics): 
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The contents of this manual and the software to which it relates are copyright protected and must not be copied or 
reproduced in any format without the written permission of NewFound Energy Limited. 
 
The specification of the Profile Portable Energy Recorder and the ProPower 3 software are subject to change without 
prior notice. This manual reflects the software capabilities at the time of writing.  
 
The ProPower 3 software was written in B4J - https://www.b4x.com. 
jPDFjet/PDFjet for Java and C# Open Source Edition - © 2017 Innovatics Inc. All rights reserved.  
Medusa Gauges Copyright (c) 2015 Gerrit Grunwald. 
jPOI /jGauges/Medusa Gauges Licensed under the Apache License, Version 2.0 - 
http://www.apache.org/licenses/LICENSE-2.0 
jCharts - with thanks to Informatix. 
 
THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY 
EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF 
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL 
THE COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, 
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT 
OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) 
HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR 
TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS 
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE. 
 
 
For information of further systems designed to assist you to use your resources more efficiently please contact 
NewFound Energy Limited on +44(0)1260 290151 or e-mail us or visit our website. 
 

info@newfound-energy.co.uk 
www.newfound-energy.co.uk/ 

 
 
 
 
 
 
 
 
 
 
 

 
Park View House, Worrall Street, Congleton, Cheshire CW12 1DT 

Tel: (01260) 290151                                                    Fax: (01260) 290811 
Web: www.newfound-energy.co.uk     e-mail info@newfound-energy.co.uk 
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